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Chapter 1: Introduction

Defining the TechniSat DVB-PC TV Stars

Defining SkyStar 2 PCI/USB
SkyStar 2 PCI is a small board that is plugged into a PCI slot of your computer. The
SkyStar USB is the USB version that is connected to a USB1.1 port of your
computer. It gives you unprecedented access to Internet services and any “Free To
Air” broadcast digital satellite television channel (DVB-S).

Defining AirStar 2 PCI/USB
AirStar 2 PCI is a small board that is plugged into a PCI slot of your computer. The
AirStar USB is the USB version that is connected to a USB1.1 port of your computer.
It gives you unprecedented access to any free to air broadcast digital terrestrial
television channel (DVB-T).

Defining CableStar 2 PCI
CableStar 2 PCI is a small board that is plugged into a PCI slot of your computer. It
gives you unprecedented access to any free available broadcast digital cable
television channel (DVB-C).

Using IP services with a DVB-PC TV Star Device
The TechniSat DVB-PC TV Stars products will request all information by ground-
based Internet. In response the requested data will be delivered using satellite,
broadband cable or terrestrial systems at high speed.

Using printed help
The DVB-PC TV Stars product range includes the 4 parts of the Users Guide (Part 1:
“Installation” / Part 2: “Setup4PC/Server4PC” / Part 3: “DVBViewer TE” / Part 4:
“Troubleshooting”).

User s guide conventions
For clarity, the User’s Guide employs the following conventions:
1. Navigation paths are represented as follows:

Start  => Programs  => TechniSat DVB  => Setup4PC
 The path shown in this example launches Setup4PC

2. Pay attention to the following:

This icon designates a note, which is an important information to the
description above.

This icon designates a warning, which is an important information to the
description above.

3. The DVB-PC TV Stars TV application “DVBViewer TechniSat Edition” is
designated in the following as “DVBViewer TE”
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User Task Summary
Steps to perform basic user tasks are summarized below.

Step one: Watch TV with DVBViewer TE
The second chapter introduces you to the main features of DVBViewer TE. You will
learn how to watch TV and configure DVBViewer TE to your needs.

Step two: Using DVBViewer TE as PVR
After you know how to use the DVBViewer TE as a television, in chapter 3 you will
learn how to use this application as a personal video recorder (PVR) and playback
software for files recorded with the PVR functionality.

Step three: Managing TV/radio channels
In the fourth chapter you will learn how to manage the channels, add/remove them
and scan a satellite for new channels with the application DVBViewer TE in
combination with your type of DVB board (SkyStar 2 TV PCI, AirStar 2 TV PCI
CableStar 2 TV PCI, SkyStar USB, AirStar USB)

Step four: IP Multicast
In this chapter the IP multicast streaming functionalities of DVBViewer TE are
described. Within this chapter you will learn to manage the function within the
DVBViewer TE and how to receive the stream with the VLC Player.

The behavior of the software regarding TV and radio reception is similar.
Most functions described within this document will be available with TV and
radio reception.
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Chapter 2: Watch TV with DVBViewer TE

Summary
This chapter is divided into three parts. In the first part, the DVBViewer TE GUI
(graphical user interface) and the main functionalities are introduced. In the second
part, the more advanced features like the EPG or the PVR are described. The third
part shows, how to use the DVBViewer TE in combination with your keyboard,
mouse or the available TechniSat remote control.

This chapter requires a correctly configured channel list. If you are using
ASTRA 19.2°E or Eutelsat Hotbird 13.0°E, the DVBViewer TE is already set
up. If you use another satellite, you have to add this to your channel list first,
before trying to receive a channel. Read chapter 4 for managing your
channel list first.

First startup
If you start DVBViewer TE for the first time, the remote control selection dialogue will
appear:

Figure 2.1: Remote Control selection: No Remote

If you don’t want to use a IR receiver, you have to select the option “No Remote” and
press the OK button.
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Configure COM Port IR Receiver / WinLIRC
If you want to use the TechniSat COM-Port IR receiver, you have to select the option
WinLIRC

Figure 2.2: Remote Control selection: Use WinLIRC

Then press the OK Button and you have to configure the WinLIRC application

1. First the following error message will appear:

Figure 2.3 WinLIRC

If this message appears, the default configuration of WinLIRC does not match
the needs of your system.

2. Press “OK” to show the configuration tab.

3. Here you have to configure the COM port (e.g. COM1), where your IR
receiver is attached.

Figure 2.4 WinLIRC Configuration

4. You also have to choose the configuration file, which contains the
configuration for your remote control. Press the “Browse” button and choose



TechniSat DVB-PC TV Stars - Users Guide Part DVBViewer TE
Chapter 2: Watch TV with DVBViewer TE

Version 4.4.0- 5 -

the file “technisat.cf” (default location: “C:\Program Files\DVBViewer TE”) in
the appeared “Open” window. Click “Open” to finish the select.

Figure 2.5 WinLIRC Open Configuration Files

5. Now your configuration has been completed. Choose “OK” to finish the
configuration and start WinLIRC.

Figure 2.6 WinLIRC Configuration completed

Configure USB HID IR Receiver
If you have a USB IR receiver you select the third option and press the OK button.

Figure 2.7: Remote Control selection: Use USB HID

The USB HID IR receiver uses keyboard commands to control the application. No
additional configuration is required.
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Device support

No device
If no compatible TechniSat DVB device is available during startup of DVBViewer TE,
the following error message will appear:

Figure 2.8: Message No valid DVB device found!

DVBViewer TE can be used as multimedia player for files, which where recorded with
this application.

Single device
If you use one single device with DVBViewer TE, the application will recognize the
used device automatically and present the GUI for the used frontend type (DVB-S /
DVB-T / DVB-C).

Multiple device
If you have installed a multiple number of compatible TechniSat DVB cards / USB
devices, the following dialog will appear:

Figure 2.9: Selection dialogue Devicelist

Here you have to select the device you want to use during the current DVBViewer TE
session. If you want to switch to another TechniSat device, you have to close
DVBViewer TE and open it again. Then you can change the used device again.

If you scheduled a recording within DVBViewer TE and switch to another
device, the scheduled recording cannot be processed.
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Watching TV - introduction

Main window

Figure 2.10: main window during DVB reception

The main window is divided into three areas:
• The first is the menu bar, which contains text-based options to the user.
• The second is the display area. This is the window, where TV programs are

displayed. The On-Screen display and the EPG info will also be displayed in
this area.

• The third is the control and tool bar. This area provides access to main
functionalities of DVBViewer TE such as EPG, teletext, PVR/time shift and
the volume control.

Control and tool Bar

Figure 2.11: control and tool bar during DVB reception

To start the time shift function of DVBViewer TE simply press the “Play/Pause”
button. If you press the “Play/Pause” button again, the time shift toggles from paused
to playback. If you press the “Stop” button, time shift will stop and DVBViewer TE
switches back to live playback.

The “left” and “right” buttons are used to switch channels up and down.

The next two buttons will open and close the teletext window and the EPG window,
which are both described in this manual.

The record button is used to start and stop manual recordings. The buttons indicates
a recording running, when the button is colored gray.

The left slider indicates the position within the program running. This slider indicates
the current position only, if EPG data are sent as part of the TV channel.

The right slider is used to control the volume. Drawn to the left will decrease the
volume, drawn to the right will increase the volume. Using the yellow “loudspeaker”
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buttons, you decrease or increase the loudness. If you want to mute the DVBViewer
TE, you have to choose this option in “Settings” => ”Mute” or use the mute button at
the right to the volume slide bar.

Watching TV - advanced features

Time shift
Time shift provides the possibility to pause and resume the running program for short
breaks. After you have held the running program, the DVBViewer records the running
program. After you have resumed the playback of the video, you can jump forward
and backward within the recorded time.

Figure 2.12: control bar during DVB reception

The time shift will be started after you have pressed the pause button of the control
bar, the stop button of your remote control or the "ESC" key. After the time shift has
started, the DVBViewer TE records the running program into a DVBViewer TE time
shift file, saved on the local hard drive.

To resume playback during time shift, you have to press the play button in control
bar, to hold the program again you have to press the pause button again. If you are
using the keyboard or remote control, you can toggle between play and pause using
the STOP-button on your remote or the "ESC" Key on your keyboard.

If you want to leave the time shift mode of DVBViewer TE, you might do this by
switching the channel you are currently watching, the time shift will be canceled
immediately. It is also possible to leave time shift by pressing the stop button in
control bar to stop time shift and resume live mode.

If a recording is scheduled while you are currently using the time shift
function, the time shift will be canceled without notice and the recording will
start immediately.

Channel list
If you want to choose a TV or radio channel directly without clicking through the
whole channel list, you might do this using the channel list of DVBViewer TE. Just
choose “Channel” => “Channellist” in menu bar or click directly the “Channellist”
button located in the tool bar.
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Figure 2.13: Channellist Channels

The “Channels”-tab of the channel list is arranged like a directory tree. Choose your
satellite, choose the type of content (Video or Audio) and select your channel. To
choose a channel, you have to double-click onto this channel, DVBViewer TE
switches directly to the selected one. For information about editing existing channels
or scan for new channels, read chapter 5.
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EPG
The Electronic Program Guide is a service of the DVB technology, which offers
additional information about the running program to end-users. DVBViewer TE is
capable to receive that kind of information and offers two methods of presenting that
information.

Not all TV station provides EPG data. That information can only be
displayed, if the chosen TV channel provides EPG data.

Please ensure that the current system date and time is set up correctly.

EPG onscreen display:
The first method is to insert the content into the display area. This option is useful if
you want to know which program is currently running and which program follows.
To display the EPG data into the view area, select “DVBViewer TE” => “Show EPG”.

Figure 2.14: main window during DVB reception with EPG OSD

There are a couple of designs for the EPG onscreen display available. To change the
settings, open the options window and select “Teletext & EPG”.
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Figure 2.15: Options menu EPG

Here you can change the appearance settings for the EPG display. If you choose “Do
not receive EPG-Data” the EPG display won’t work caused by the fact, that no EPG
data will be available.

The option “Automatic Offset” will enable the synchronization of the GMT offset with
the timezone configuration of your Windows operating system. If this option is
disabled, you have to configure the GMT offset manually.

EPG window:
The second method for displaying EPG content in combination with DVBViewer TE is
to use the EPG window. This is arranged like a “TV magazine” with programs sorted
by channel and time.

Figure 2.16: EPG window

Using the EPG window, you gain access to additional information, which are not
shown within the EPG display. It is also possible to save the EPG data to your hard
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drive as HTML TV magazine. For this purpose the “Save EPG” button opens the
save as dialog.

Figure 2.17: Save as dialog

Enter the location and the name of the files and press the “Save” button. All known
EPG data will be combined into a set of HTML files, which can be displayed with a
web browser

Figure 2.18: Browser with opened DVBViewer TE HTML EPG

The second option is the capability of sending programs directly to the DVBViewer
TE recorder module. This option is described in chapter 4 “Using DVBViewer TE as
PVR”
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Teletext
Using DVBViewer TE you also gain access to the teletext services of most TV
stations. Open the teletext window by using the Teletext button in Toolbar or using
the menu “DVBViewer TE” => “Teletext”.

Figure 2.19: Teletext window

The usage of this application is very simple. Enter the page number using the
number buttons in the toolbar of the Teletext window or enter those numbers using
your keyboard or remote control. Use the forward/reverse button nearby the number
field to navigate through the pages. You might also access sites by clicking on
displayed page numbers with the left mouse button.

Subtitle
The DVBViewer TE supports showing and recording of teletext and DVB subtitles. By
selecting the menu "View" => "Show Subtitle" the option will be enabled.

Teletext subtitles:

Figure 2.20: Subtitle dialogue for teletext subtitles

After the subtitle page number is entered and the "OK" button is pressed, the subtitle
teletext will be shown in display area.

If the specified subtitle teletext page is not available, no subtitle will be
shown in display area.
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DVB subtitles

Figure 2.21: Subtitle dialogue for DVB subtitles

After selecting the language of the DVB subtitle, press the “OK” button and the
subtitle will be shown in display area

Figure 2.22: Main window during DVB reception with subtitle

If the subtitle function is enabled and you start a recording of this program, the
subtitle will also be recorded. If you playback a recorded program with recorded
subtitle using DVBViewer TE, the option "View" => "Show Subtitle" is available. If you
enable "Show Subtitle", the recorded subtitle will be shown in display area.

Selecting the menu "View" => "Show Subtitle" again will disable the subtitle display.

The teletext subtitle function requires a channel with teletext and at least one
subtitle page. If the channel does not provide teletext information, this option
is unavailable.

The DVB subtitle function requires a channel with DVB subtitle information. If
the channel does not provide those data, this option is unavailable.
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Configure the application
Within the DVBViewer TE options menu you can configure most functionalities of
DVBViewer TE to your needs. First the general and enhanced options are
introduced.

“General” options
Within the general options you can configure the main settings of DVBViewer TE.

Figure 2.23: Options General

Use XP-Icon Style:
This option can be used only while the skin engine is disabled. It toggles
between the XP style icon set and a alternative icon set.

Use Skin-Engine
This option toggles the skin engine of DVBViewer TE on/off

Hide the mouse cursor in fullscreen mode in secs
This option configures the timeout, when the mouse cursor will be hidded in
full screen mode

Hide the title bar
This option toggles the title bar on/off and is available with disabled skin
engine only.

Prevent Screen saver
This option toogles the screen saver prevention on/off.

Use first CPU
This option enables the usage of the first CPU within SMP/HT/Dual Core
systems

Language
Here you can select the GUI language. Select the required language and
press the set button.
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EIA 608 – Closed caption
This option configures the delay transmission and appearance of closed
captions (if available)

Enhanced options

Figure 2.24: Options Enhanced

Ignore Error messages
Toggles error messages on/off

Show Error only on OSD
Disables/enables error messages shown as overlay and not as pop-up
window

Remember the last channel
If this option is enabled, DVBViewer TE will tune the last channel after startup
automatically.

Zapping Delay in milliseconds
The delay time will be use to delay channel switch command..

Show Controlbar
Toggles the controlbar on/off and is available with disabled skin-engine only.

Render Output
Configures the render output format.

Fast channelswitch
Toggles the fast channel switching feature on/off. If this option is enabled,
DVBViewer will not retune, if the selected channel is located on the current
transponder.
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Use DVBSource for files
Toggles the compatibility mode for the playback of transport stream formatted
MPEG-2 files on/off.

Show DVB-Viewer in…
This option toggles the appearance of DVBViewer TE between the taskbar,
the system tray or both.

The other option windows are described within the following chapters of this
document within the chapter context.
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Control the application

Keyboard
A list of assigned keyboard commands is given in Appendix B.

If you want to change the default settings to your needs, you might do this using the
Keyboard tab in “Settings” => “Control”

Figure 2.25: Options menu Control Keyboard

If you use a remote control with the USB IR receiver, you also have to
configure the settings of the remote control within the keyboard
configuration. The USB IR receiver uses keyboard commands to control the
application.
The USB IR receive is not compatible to WinLIRC.
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Mouse Wheel
If you want to change the default settings to your needs, you might do this using the
Keyboard tab in “Settings” => “Control”

Figure 2.26: Options menu Control Mouse Wheel
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TechniSat Remote Control
A list of assigned commands is given in Appendix B for the current TechniSat remote
controls

If you want to change the default settings to your needs, you might do this using the
WinLIRC tab in “Settings” => “Control”

Figure 2.27: Options menu Control WinLIRC

If you use a remote control with the USB IR receiver, you have to configure
the settings of the remote control within the keyboard configuration. The
USB IR receiver uses keyboard commands to control the application.
The USB IR receive is not compatible to WinLIRC.
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Chapter 3: Using DVBViewer TE as PVR

Summary
This chapter shows how to use the built in PVR functionalities for recording and
playback of DVBViewer TE and also how to play recorded videos with third party
software.

Necessary settings
Before you record files for the first time, you should be sure that there is enough
space available for recording DVB content.

DVB TV channels could create data rates with up to 25Mbit/s. For this
purpose you need more than 10GB of free hard disc capacity for one hour of
recording time.

Figure 3.1: Options menu Recorder

Specify location with enough free available space.

If you are using the FAT32 file system, you have to split files caused by the
fact, that FAT32 can handle files up to 4GB only. In this case you have to
check the “Split files” checkbox.

You should also split files, if you want to backup the recorded files with CD or DVD
recorders. If you are using NTFS formatted drives and don’t want to save files to CD
or DVD, there is no need to enable the file splitting.
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Record programs manually
To start a manual recording, press the red button in the tool bar. You can also use
the keyboard shortcut or the button on your remote control.

Figure 3.2: Tool bar during DVB reception

The recording starts immediately. If you want to stop the recording, press the record
button again.

If you change to another channel during a recording, the "Recorder is
active!" message appears

Figure 3.3: "Recorder is active!"

If you press "OK", the recording will stop and the DVBViewer TE tunes the chosen
channel. If you press "Cancel", the DVBViewer TE remains in recorder mode.

The recorded file will be saved in the specified directory.

Record programs automatically
The PVR functionality of DVBViewer TE provides a recording schedule, which can be
programmed manually or by using the EPG.

Your PC must be active and DVBViewer TE must be started for scheduled
recording. If DVBViewer TE is not started or the system is not active while
passing a scheduled event time the event entry will be discarded without
recording.

If a recording is scheduled and while you are time shifting a TV program, the
time shift will be canceled without notice and the recording starts
immediately.
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Add events to recorder manually
Using the recorder window of DVBViewer TE it is possible to add multiple events to
the recording scheduler. You’ll find the recorder window by choosing “DVBViewer
TE” => “Record Setting”.

Figure 3.4: Recorder window

To add a new event to the scheduler, enter the event date, start and end time, the
channel number and the event description. You might take the channel number using
the tree view of the channel list located at the left side of the recorder window. Click
“Add” to add the event to the scheduler. If you want to remove an event, choose it
and click “Remove”. If you want to edit an existing event, choose this event and edit
the necessary values. After this, press “Update” and the scheduled event will be
updated.
If you enable the option “Shutdown after recording”, DVBViewer TE will shutdown
your system after finishing the last scheduled element.
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Add events to recorder using the EPG
For all channels, which provides EPG data, you might use the EPG window to add
recording timers to the recorder timetable

Figure 3.5: EPG window

To add events using the EPG, you have to open the EPG window. Select the event,
you want to record and press the “Send to PVR” button.
This event will be added to the recorder scheduler and automatically recorded on
your hard drive.

If a recording is scheduled and while you are time shifting a TV program, the
time shift will be canceled without notice and the recording starts
immediately.
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Play recorded programs with DVBViewer TE

Play files with DVBViewer TE
To play recorded files with DVBViewer TE, open the video using “DVBViewer TE” =>
“Open Video” or use the “Change TV/Video Mode” button in the tool bar.

Figure 3.6: control and tool bar during DVB reception

After DVBViewer TE has loaded the file the playback will start immediately.

Figure 3.7: main window in playback mode

There are several ways of returning to TV mode. Choose a channel by using the
graphical interface, your keyboard or a remote control.

Play files with third party software
Almost every media player like the Windows Media Player 9 is capable for playback
a file recorded by DVBViewer TE.

To playback a file, the TechniSat DVB software and the DVBViewer TE must
be installed in the system.

If you want to play a file recorded using DVBViewer TE in a system without
this software, you have to transcode the file(s) to normal MPEG2 files.
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Chapter 4: Managing TV/radio channels

Summary
This chapter shows how to manage TV/radio channels and perform imports and
exports of the database with your DVB-PC TV card. It is divided into three parts, one
for each device type:

SkyStar2/SkyStar USB for satellite reception
AirStar2/AirStar USB for terrestrial reception
CableStar2 for cable reception

SkyStar2 PCI/USB

Edit existing channels
If you want to edit an existing channel in DVBViewer TE channel list, you have to
select this channel in the channel list and switch from “Channels”-tab to ”Edit”.

Figure 4.1: Channellist Channels  and Edit

Here you have to enter the new values and press the “Update” button. The changed
settings for this channel will be added to the current channel list.
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Edit satellite parameters (DiSEqC settings)
If you use DiSEqC settings, which differ to the default settings of DVBViewer TE, you
have to change those settings for each satellite you are able to receive using your
equipment. For this purpose choose a satellite in the channel list and switch to the
tab “Edit”. The settings for the satellite will be displayed.

Figure 4.2: Channellist Edit  satellite settings

Here you have to select the correct DiSEqC settings for the satellite and press
update to confirm the change of the DiSEqC parameter. Those settings will be valid
for all TV and radio channels which are listed within the channel list of this satellite.

Using the “Clear All” button you can remove the whole satellite tree of the selected
satellite.
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Add/Remove channels manually
If you want to add or remove channels manually, you also have to use the edit tab.

Figure 4.3:Channellist Channels  and Edit

To add a new channel, you have to enter the necessary values; press “Add”...

Figure 4.4: Channellist add channel popup message

...and confirm the appearing message. This channel is now added to your channel
list.

To remove an existing channel, you have to select a channel using the tree view of
the channel list and select a TV station. Then switch to the “Edit” tab and click the
button “Delete”...

Figure 4.5: Channellist delete channel popup message
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...and confirm the appearing message. This channel is now removed from the
channellist.

To clear all channels from the channel list, you have to click the button “Clear All”...

Figure 4.6: Channellist delete all channels popup message

...and confirm the appearing message. The channel list should been cleared
completely.

If you clear an existing channel list, all information will be deleted. Please
create a backup of your channel list before clearing, with the channel list
export function of DVBViewer TE.
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Scan for new channels
Another way of adding new channels is the “Channel Scan”.

Figure 4.7: Channellist Channel Scan

To start a channel scan you should select a satellite root first, DVBViewer TE will
scan for channels using a transponder list for the satellite system selected. If you
want to scan for channels without a transponder list, enter a name for the satellite
only, which is not used by the existing lists.

After selecting the root list, you have to select the used LNB type. The default “Ku-L
Band” LNB is used for frequencies between 10.7 and 12.75GHz with linear
polarization. The other LNB type options are “Ku-C Band” for circular polarization and
“C-Band”.

You need to enter a name for the scanned root, the values for the used LNB and the
frequency area you would like to scan. If you want to update an existing channel list
for a satellite, check the “Scan & Update” option. Press the “Scan” button to start the
scanning process.

The scan procedure might take several minutes to complete.
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After the procedure has been completed, you will find the added channels browsing
the specified root name at the end of the channel list. If you updated an existing root,
the channels, which do not longer exist, should be removed and new channels
should be added to the list.

Import/Export channel lists with DVBViewer TE
The third option for adding channels to DVBViewer TE is to import existing channel
lists. For this purpose you need a channel list provided as a file.

Figure 4.8: Channellist Channels

To import an existing channel list to DVBViewer TE, click the button “Import” in the
channel list and choose the file, which contains the channel data.
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Figure 4.9: Import Channellist Open  window

The information will be added to the existing channel list.

The following file-types can be imported to the DVBViewer TE:
TechniSat Program List (*.txt)
Microsoft Access Database (*.mdb)
SatcoDX Channels (*.sdx)
Ini File (*.ini)

To export your current channel list (e.g. for backup), click the “Export” button in the
channel list and specify the destination directory and file name.

Figure 4.10: Export Channellist Save As  window

The DVBViewer TE channel list can be exported to the following file-types:
Ini File (*.ini)
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CableStar2 PCI

Edit existing channels
If you want to edit an existing channel in the DVBViewer TE channel list, you have to
select this channel in the channel list and switch from “Channels”-tab to “Edit”.

Figure 4.11: Channellist Channels  and Edit

Here you have to enter the new values and press the “Update” button. The changed
settings for this channel will be added to the current channel list.
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Add/Remove/Update channels manually
If you want to add or remove channels manually, you also have to use the “Edit”-tab.

Figure 4.12: Channellist Channels  and Edit

To add a new channel, you have to enter the necessary values, press “Add”...

Figure 4.13: Channellist add channel popup message

...and confirm the appearing message. This channel is now added to your channel
list.

To remove an existing channel, you have to select a channel using the tree view of
the channel list and select a TV station. Then switch to the “edit”-tab; click the button
“Delete”...

Figure 4.14: Channellist delete channel popup message
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...and confirm the appearing message. This channel is now removed from the
channellist.

To clear all channels from the channel list, you have to click the button “Clear All”...

Figure 4.15: Channellist delete all channels popup message

...and confirm the appearing message. The channel list should been cleared
completely.

If you clear an existing channel list, all information will be deleted. Please
create a backup of your channel list before clearing using the channel list
export function of DVBViewer TE.

Scan for new channels
Another way of adding new channels is the “Channel Scan”.

Figure 4.16: Channellist Channel Scan

This option should be used to scan for available cable TV channels or to update one
root of the existing channel list. You need to choose the modulation type (in our
example QAM64) and to enter the start and end frequency. If you want to update an
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existing channel list for your cable TV system, check the “Scan & Update” option.
Press the “Scan” button to start the scanning process.

The scan procedure might take several minutes to complete

After the procedure has been completed, you’ll find the added channels browsing the
specified root name in the channel list. If you updated an existing root, the channels,
which do not longer exist should be removed and new channels should be added to
the list.

Import/Export channel lists with DVBViewer TE
The third option for adding channels to DVBViewer TE is to import an existing
channel list. For this purpose you need a channel list provided as a file.

Figure 4.17: Channellist Channels

To import an existing channel list to DVBViewer TE, click the button “Import” in the
channel list and choose the file which contains the channel data.
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Figure 4.18: Import Channellist Open  window

The information will be added to the existing channel list.

The following file-types can be imported to the DVBViewer TE:
TechniSat Program List (*.txt)
Microsoft Access Database (*.mdb)
SatcoDX Channels (*.sdx)
Ini File (*.ini)

To export your current channel list (e.g. for backup), click the “Export” button in the
channel list and specify the destination directory and file name.

Figure 4.19: Export Channellist Save As  window

The DVBViewer TE channel list can be exported to the following file-types:
Ini File (*.ini)
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AirStar PCI/USB

Edit existing channels
If you want to edit an existing channel in the DVBViewer TE channel list, you have to
select this channel in the channel list and switch from “Channels”-tab to “Edit”.

Figure 4.20: Channellist Channels  and Edit

Here you have to enter the new values and press the “Update” button. The changed
settings for this channel will be added to the current channel list.
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Add/Remove/Update channels manually
If you want to add or remove channels manually, you also have to use the “Edit”-tab.

Figure 4.21: Channellist Channels  and Edit

To add a new channel, you have to enter the necessary values, press “Add”...

Figure 4.22: Channellist add channel popup message

...and confirm the appearing message. This channel is now added to your the
channel list.

To remove an existing channel, you have to select a channel using the tree view of
the channel list and select a TV station. Then switch to the “edit”-tab; click the button
“Delete”...

Figure 4.23: Channellist delete channel popup message
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...and confirm the appearing message. This channel is now removed from channel
list.

To clear all channels from the channel list, you have to click the button “Clear All”...

Figure 4.24: Channellist delete all channels popup message

...and confirm the appearing message. The channel list should been cleared
completely.

If you clear an existing channel list, all information will be deleted. Please
create a backup of your channel list before clearing using the channel list
export function of DVBViewer TE.

Scan for new channels
Another way of adding new channels is the “Channel Scan”.

Figure 4.25: Channellist Channel & Scan

This option should be used to scan for available terrestrial TV channels or to update
one root of the existing channel list. You need to choose your region (Europe,
Australia or Taiwan) and to enter the start and end frequency. If you want to update
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an existing channel list for your DVB-T region, check the “Scan & Update” option.
Press the “Scan” button to start the scanning process.

The scan procedure might take several minutes to complete.

After the procedure has been completed, you will find the added channels browsing
the specified root name in the channel list. If you updated an existing root, the
channels, which do not longer exist, should be removed and new channels should be
added to the list.

Import/Export channel lists with DVBViewer TE
The third option for adding channels to the DVBViewer TE is to import an existing
channel list. For this purpose you need a channel list provided as a file.

Figure 4.26: Channellist Channels

To import an existing channel list to the DVBViewer TE, click the button “Import” in
the channel list and choose the file, which contains the channel data.
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Figure 4.27: Import Channellist Open  window

The information will be added to the existing channel list.

The following file-types can be imported to the DVBViewer TE:
TechniSat Program List (*.txt)
Microsoft Access Database (*.mdb)
SatcoDX Channels (*.sdx)
Ini File (*.ini)

To export your current channel list (e.g. for backup), click the “Export” button in
channel list and specify the destination directory and file name.

Figure 4.28: Export Channellist Save As  window

The DVBViewer TE channel list can be exported into the following file-types:
Ini File (*.ini)
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Sorting channels
Within the DVBViewer TE it is possible to alter the order of the channels.

One method is to rename the folders, in which the channels are located. Using this
mechanism will create a new folder at the top of the satellite root. Please select the
channel you would like to place into another category. Then switch to the “Edit” tab
and rename the category to the new category name. This might be a name, which
already exists or this might be a new name. New categories will be put at the top of
the list.

The other method is to move the channels up and down until they are at the position
you prefer. For moving one channel up or down, press and hold the “CAPS” key and
use the up or down arrows to move the channel up or down.

It is not possible to move channels from one satellite to another and it is also
not possible, to move a TV channel into a radio channel list or a radio
channel into a TV channel list.

Example
Within our example, we want to get all major BBC channels into a folder named BBC.
Therefore we select one of the BBC channels first – in our example the channel
“BBC Four”.

Figure 4.29: Channellist Channels
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Now we switch to the edit tab and replace the category name named “English” with
“BBC” and press the update button.

Figure 4.30: Channellist Channel  and Edit
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Now there is a new category named “BBC” at the top of the channel list.

Figure 4.31: Channellist Channels

Now we can start to move the channels into this folder by renaming the category or
by moving the channels up to the category “BBC”. In our example we now move the
channel “BBC ONE England (London)” to the category “BBC”.
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Figure 4.32: Channellist Channels  before and after channel move
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Chapter 5: IP multicast Streaming

Summary
This chapter will introduce the IP multicast streaming functionalities, which are part of
the DVBViewer TE.

Recommended system requirements
• Supported operation systems:

Windows 2000 Professional/Server (service pack 4 required)
Windows XP Home Edition/Professional (service pack 2 required)

• Two computer systems, both equipped with fast Ethernet network adapter
cards, which are capable to handle at least 100MBit/s

• Direct connection cable
or
• 100/1000 Mbit/s Ethernet switch
or
• 100/1000 Mbit/s Ethernet hub

Important information
This HOWTO requires two computer systems, which are configured to operate in a
local area network (LAN) environment. The internal IP network settings should be
configured correctly and the wiring and distribution components should be connected
correctly.

To stream a normal TV station, you have to ensure, that your network is
capable to handle a transfer rate of up to 15MBit/s. If you want to stream
HDTV channels, you will need up to 80MBit/s.

Network streaming works well at a data rate of up to 8MBit/s. If you want to
stream channels, which requires more than 8MBit/s, it should work properly,
but this depends on the quality of the used infrastructure components. Some
switches cannot handle higher bandwidth over a long time period and might
break down during operation. The same is also valid for SoHo broadband
routers with integrated switches used for broadband connections.
You need an MPEG-2 software decoder installed on the streaming client
machine to decode the received DVB content.

WARNING:
If you want to use IP multicast transfers in large-scale environments, ensure
that the switching components are capable to handle multicast transfers and
the network routers in this environment are configured to block IP multicast.
Otherwise heavy network problems might occur. Contact your system
administrator first, before starting a multicast stream in your environment.
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Streaming of one TV channel trough a network

Building a network environment for IP streaming
The common system requirements are listed below:
PC 1:

• One operable DVB-PC TV Stars device
• One configured network interface (100BaseTX or 1000BaseTX)
• 3D AGP/PCIe Graphic card with hardware acceleration
• DVBViewer TE

PC 2:
• One configured network interface (100BaseTX or 1000BaseTX)
• 3D AGP/PCIe Graphic card with hardware acceleration
• A streaming client software installed (e.g.: VideoLAN Client)

In our example we are using two systems:

Figure 5.1: Multicast test configuration

The multicast server is equipped with a SkyStar USB card and correctly connected to
a dish. The satellite on which the dish is aligned to and the channel, which will be
streamed over the LAN, is unimportant for this example.
The connection between both systems will be realized with a cross-over network
cable for direct connection. It is also possible to use a 100/1000MBit/s network switch
or a 100/1000MBit/s Ethernet hub.
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On our server, we open "Settings" => "Options" and change to the "Recorder" tab.

Figure 5.2: Options menu Network

Here you have to configure the necessary options for the IP multicast stream.
First you have to choose the IP-address of the network interface, the multicast
stream is sent for distribution. In our example, the network interface has the IP
192.168.0.1

The second information, which is necessary for IP multicast, is the multicast address
and the port the stream is located on.
If the MC-IP is valid, MC-IP field is filled with green colour. If the IP is invalid, the field
is red.
The multicast IP range is specified in RFC 1112 (Aug-01-1989) and the following
RFC documents. Multicast IP addresses are defined to the range between 224.0.0.0
to 239.255.255.255. If you want to send the stream to all clients in your subnet, you
have to use the multicast IP 224.0.0.1. For further information about multicast IP
addresses you should read the RFC document.
The multicast port number, you have to choose, can be chosen from the range
between 0 and 65500. You should not use the first 1024 ports because they are
reserved/used by IP services.
In our example we use the multicast IP 224.0.0.1 for all clients in the local subnet and
the port number 7792.

Now press OK to confirm the settings and close the options window.

Now you can start the multicast IP streaming.
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Figure 5.3: Main window View  menu with disabled multicast option

To initialise the multicast stream, choose "View" => "Multicast". Now the current
channel will be sent to the selected network interface.

To receive and view the data stream, a streaming client is required. In our example
we use the application "VLC Media Player". This open source application is available
at the project website http://www.videolan.org/vlc/.

Start the application.

Figure 5.4: VLC media player

Here you simply click onto "File"...

http://www.videolan.org/vlc/
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Figure 5.5: VLC media player File  menu

... and then select the option "Open Network Stream...".

Figure 5.6: VLC media player Open  menu

Then you have to choose "UDP/RTP Multicast" and enter the address and port
number where the multicast IP stream is located on.
Then press the "OK" button and VLC Media Player will start the playback of the
stream immediately.
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Figure 5.7: VLC media player during multicast stream playback

If you want to stop the streaming client playback, simply press the stop button.
If you want to stop the streaming server of DVBViewer TE, you have to uncheck the
"Multicast" option in "View" menu.

Figure 5.8: Main window View  menu with enabled multicast option
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 Appendix A: Additional information

Technical support / contact:

Germany
Postal address:

TechniSat Digital GmbH
Julius-Saxler-Strasse 3
D-54550 Daun
Germany

Homepage:
 http://www.technisat.de

Support hotline (german only):
mo-fr from 8:00h to 19:00h

0180-5005910 (0,12 EUR / min)*
Remaining time

0190-151576 (0,62 EUR / min)*
(* conventional german telephone network)

Support email:
service@technisat.de

International
Postal address:

TechniSat Data Services S.A.
11, rue Pierre Werner
L-6832 Betzdorf
Luxembourg

Homepage:
 http://www.technisat.com

Support email:
support@technisat.com

http://www.technisat.de
mailto:service@technisat.de
http://www.technisat.com
mailto:support@technisat.com
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Appendix B: TechniSat remote control and keyboard
commands

TechniSat TS35

 Recorder window
Aspect ratio

 Exit
Mute

 Start / stop recording
Number field

 Show / hide menu
EPG info

 Channel up/down
Volume up/down

 Pause / resume
EPG window

 Full screen
100% size

 200% size
50% size

 DesktopTV
Teletext

 Stop

Figure B.1: TechniSat remote control T35 (default configuration)
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TechniSat TTS35AI

Mute  Exit

Number field

Start / stop recording  Recorderwindow

100% size  200% size

50% size  Desktop TV

 Channel up/down 1

Volume up/down 1

 Pause / resume

 Full screen

EPG window  EPG info

Channel up/down 2  Volume up/down 2

 Menu

 Aspect ratio

Teletext  Stop

Figure B.2: TechniSat remote control TS35AI (default configuration)
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Keyboard commands
Assigned short keys (default settings):

Pause / resume P
Always On Top F1
Hide Menu F2
Show Statusbar F3
Show Toolbar F4
Fullscreen F
Exit ESC

Channel list C
Channel Minus DOWN ARROW
Channel Plus UP ARROW
Save Channel CTRL + S
Station Minus PgDown
Station Plus PgDup

Aspect Ratio V
Zoom Z
Options O

Mute M
Volume Up RIGHT ARROW
Volume Down LEFT ARROW

Display D
50% size F5
100% size F6
200% size F7
Desktop TV F8

Record settings S
Record video/audio R
Teletext T
Mini EPG I
EPG Window E

Change TV/Video F9
Show Subtitle F10
Plus 10 sec. -
Minus 10 sec. +

Number 0 0
Number 1 1
Number 2 2
Number 3 3
Number 4 4
Number 5 5
Number 6 6
Number 7 7
Number 8 8
Number 9 9

Favorite 1 SHIFT + 1
Favorite 2 SHIFT + 2
Favorite 3 SHIFT + 3
Favorite 4 SHIFT + 4
Favorite 5 SHIFT + 5
Favorite 6 SHIFT + 6
Favorite 7 SHIFT + 7
Favorite 8 SHIFT + 8
Favorite 9 SHIFT + 9
Favorite 0 SHIFT + 0
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Appendix C: Glossary

Band Part of the radio spectrum occupied by a signal.

BER Bit Error Rate

Carrier Frequency Electromagnetic radiation that is modified to represent
broadcast information for transfer across distances. See
Modulation and Demodulation.

Converter The device in the satellite dish, which amplifies the radiation
from the satellite and converts it to an intermediate frequency
(from 950 to 2,150 MHz), before the signal reaches coaxial
cable that connects the antenna to the receiver Also-called
Universal converter can receive signal from most European
satellites.

DBW Value in decibels of the signal broadcast by the transponder
at the center of its footprint. The higher the value, the smaller
the dish can receive the signal.

Decibel (dB) Logarithmic measurement used to indicate increase or
decrease in signal quality.

Demodulation The reconstruction of original signal from radiation that has
reached the end user’s reception equipment. This commonly
occurs at the tuner. See Modulation.

Digital Broadcasting system based on the mapping of images and
sounds to binary data formats. In Europe, the DVB standard
is used.

DiSEqC Device that connects the receiver and other equipment in a
satellite receiving system, using coaxial cable to transmit
signals to each component.

Dish The satellite antenna. It is a parabolic surface which reflects
the received signal towards the converter. The larger the
dish, the better the signal quality.

Down-link Signal path from satellite transponder to Earth.

DSR (Digital Satellite
Radio)

Digital audio broadcasting system used by some German
channels. It requires a special receiver.

Dualband Converter, which is able to receive two different frequency
bands at the same time.

Dualpole “Marconi” converter, which receives both polarities
(horizontal and vertical). Users select polarities by means of
a voltage change (13 / 18 Volt).
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DVB (Digital Video
Broadcasting)

The digital broadcasting standard for Europe, based on
MPEG-2. Developed by an international consortium, it is
available in three flavors:
DVB-S for satellite, DVB-C for cable TV and DVB-T for
terrestrial.

Encryption Scheme for scrambling subscriber television or radio.

EPG (Electronic Program
Guide)

An on-screen listing that let digital television watchers see
such information as time, channel, and content for current
and upcoming programs.

FEC (Forward Error
Correction)

Bits added to the transmitted data to check transmission
errors and allow their correction at user’s side. It is written as
a fraction: the lower the value (e.g. 2/3 instead of 5/6), the
higher the percentage of extra transmitted bits.

Feed Antenna dish component, which aims the signal reflected by
the dish towards the LNB.

Footprint The area covered by the satellite or transponder signal.

GEO Geo-stationary Earth Orbit, 36,000 km above the equator.
Satellites at this altitude have the same angular rotation
velocity as the Earth, meaning their signal can be received
continuously at fixed points on the ground.

Geo-stationary Orbit See GEO.

HDTV High Definition Television

Intermediate frequency Frequency band originated from LNB that the receiver can
tune. The typical band is 950 - 2,150 MHz.

ISP Internet Service Provider.

LNB (Low Noise Block
converter)

See Converter.

Local Oscillator Converter component, which shifts the converter received
frequency (from 11,000 to 13,000 MHz) to the intermediate
frequency band.

MAC Media Access Control. An addressing scheme for data.

Modulation The process by which electromagnetic radiation is modified
to represent digital or analog input for transfer across
distances. In modulation, electromagnetic waves are typically
altered as to phase and other characteristics, according to
the type of information they convey.
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MPEG-2 Digital data compression format, which uses powerful
algorithms to greatly reduce the size of final data. Developed
by an international research group (the Motion Picture Expert
Group-MPEG) it is the system used to compress the digital
data for the DVB signals.

Multi-feed Two or more converters positioned on the same fixed
antenna dish to get signals from two or more satellites whose
orbital positions are sufficiently close to each other.

Oscillator See Local Oscillator.

PID (Packet Identification
Code)

A code assigned to a unit of data before it leaves the
transmitter, based on such particulars as the program of
which the data is apart, and the type of data, e.g., audio,
video. The term ‘PID’ is also used to refer to the unit of data
itself. A typical channel comprises several PIDs.

Polarization Characteristic behavior of the electromagnetic waves. In
satellite transmission the polarization can be horizontal or
vertical.

Polarizer Device on end-user equipment, which separates vertically
and horizontally polarized waves.

QPSK, QAM Modulation schemes for satellite and cable TV, respectively.
See Modulation and Demodulation.

Sampling Conversion of analogue signal to numeric data, measuring
an electric signal at a predefined pace.

Satellite Chart A free, public source of information about each orbiting
satellite, its channels, polarities, symbol rates, and the like.
SatcoDX is an example of an organization that maintains
such a chart.

Satellite Database The database of channels that ships with SkyStar PCI. The
factory database includes channels from the Astra satellite,
and maybe modified at anytime using Channel Management
or by performing a Scan.

Satellite List The list of satellites available from the satellite database.

SDTV Standard Definition Television

Symbol Describes radiation that has been modified to represent
digital information. Symbol characteristics such as phase
represent particular configurations of binary data. A Carrier
Frequency is manipulated into symbol. See also Modulation
and Demodulation.

Symbol Rate The speed at which the satellite sends symbol, or data,
expressed in symbols per second. Different modulation
schemes use different symbol rates.
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Transponder Device on the satellite, which can receive terrestrial input and
transmit it back to the Earth in the form of a broadcast. Each
transponder typically handles several channels.

Universal LNB A converter equipped with two local oscillators. The Low
Band one is at 9,750 MHz; the High Band one is at 10,600
MHz. Using this LNB the maximum frequency in Ku band
(12,750 MHz) is shifted to 2,150 MHz.

Up-link Signal path from the Earth to the satellite transponder.


